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ICT: Using resources effectively
‘How do I get them to stop playing and start thinking?’

Module overview

This module explores the pedagogical and practical challenges that confront teachers as
they help pupils to use ICT effectively in solving problems and learning mathematics. In
this module we look at contrasting uses of the computer: a 'microworld' to explore, a
generic 'thinking tool' and a didactical tool.  Through planning, implementing and reflecting
on lessons using the computer, the role and significance of ICT in mathematics and its
relationship to the traditional curriculum are explored.

This guide is intended for use alongside the Bowland Maths DVD or website, which include
a short introductory video for each of the activities; longer videos of lessons and teacher
discussions and links to all the handouts and ICT-based problems. Please ensure that the
two software ‘microworlds’ are installed and tested on participants’ computers
before the session – see the Resources index for this module on the DVD or website.

Introductory session 1 hour

• Explore using  ICT as a "microworld"
• Reflect on the uses of ICT in your school
• Observe another teacher using ICT
• Plan a lesson using ICT

Into the classroom 1 hour

• Introduce the microworld to the class
• Pupils explore the microworld and generate problems
• Pupils describe what is happening and share problems to explore
• Pupils work on the problems
• Pupils report back and share findings

Follow-up session 1 hour

• Reflect on the Spirolaterals or Dance Moves lesson
• Explore the use of ICT as a thinking tool: Magazine Sales
• Observe a teacher using Magazine Sales
• Relate ICT to the new Programme of Study for Mathematics
• Look at the use of ICT in the Case Studies
• Consider using other resources to provoke thinking (optional)

Resources Needed

 Handout 1 Two microworlds to explore

 Software Spirolaterals ‘microworld’

 Software Dance moves ‘microworld’

 Handout 2 Roles of ICT in the maths classroom

 Handout 3 A checklist for using ICT

 Handout 4 Making and selling a magazine

 Handout 5 Spreadsheet hints

 Handout 6 Mathematics Programme of Study: Key stage 3

 Handout 7 Notes on the problems

 Handout 8 Suggested further reading
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Activity 2 Reflect on the uses of ICT in your school 10 minutes

 Handout 2 proposes three categories for the roles ICT can play in school mathematics:

• A microworld providing a rich, motivating domain to explore
(e.g. Spirolaterals, Dance Moves and other specific 'applets')

• A thinking tool for working on Mathematics
(e.g. graphics calculator, spreadsheet, database, graph plotter, dynamic geometry)

• A didactic tool that attempts to explain mathematics and develop fluency in routine
skills in more motivating ways. (E.g. electronic textbook, PowerPoint presentation,
computer games to develop fluency with multiplication tables)

Refer to  Handout 2 and discuss the following questions:

• Which microworlds, thinking tools, and didactic tools do you use in
mathematics?

• What relative importance do you give to each of the 3 roles in your
lessons?

• How far do your pupils regard ICT as a natural medium for doing
mathematics?
(Or is the most powerful mathematical tool still the back of an
envelope?)

You may like to watch Rob, Peter and Christine as they discuss the
ways they use ICT in their school.

Activity 3 Observe another teacher using ICT  20 minutes

Now watch Rob using Spirolaterals with his class.

• How does the teacher help pupils engage with the situation?
• What resources other than computers are made available to

pupils?
How are these used?

• What problems do the pupils create?
• How does the teacher encourage pupils to stop 'playing' and start

thinking?
• What potential can you see for developing mathematics in this

lesson?

Later, you may also like to watch Christine as she uses the software
Dance moves.



ICT: Using resources effectively Introductory session

r3 © 2008 Bowland Charitable Trust I-4

Activity 4 Plan a lesson using ICT  15 minutes

Now it's your turn to plan a lesson using Spirolaterals or Dance
Moves.

Discuss your answers to the following questions

• What is the best way to introduce the activity to pupils?
• How will you ensure that pupils progress from "playing around" to

working systematically and recording their thinking?
• When and how will you enable pupils to share their ideas and

strategies?

On  Handout 3, you will find some more general suggestions and
advice on planning lessons which use ICT.

This is the end of the Introductory session. After you have tried out your lesson with your
own pupils, return for the Follow-up session.

Resources to support the lessons, and suggested lesson plans, can be found in the Into
the classroom session.
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ICT: Using resources effectively
‘How do I get them to stop playing and start thinking?’

Into the classroom

The following suggestions describe one possible approach to using the microworlds
Spirolaterals or Dance Moves with your pupils. Each microworld will need between one
and two lessons. Although the plans are presented together, we do advise, that you only
use one program at a time!

Introduce the microworld to the class 5 minutes

Spirolaterals Dance Moves

Each lesson needs very little in the way of introduction. Give each pupil a copy of the
appropriate handout and explain the purpose of the lesson:

The aim of today's lesson is for you to explore a simple computer program.
Your task is to try to answer these questions:

• What does the program do?
• What interesting problems does it suggest to you?
• Can you solve any of these problems?
• Can you make any conjectures and prove them?

Explain how pupils are expected to work:

I want you to work in pairs to see how the software works.

Try to record precisely what happens when you enter different numbers/ press
different buttons.

As you do this, begin to think of some possible problems to investigate.
You might, for example make up problems that start with the words:

Spirolaterals
"How can we make the computer draw ....?"
"What will happen if we .....?"
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Dance Moves
"How many different ways...?"
"How can I make the dancers move so that...?"
"How many beats would....?"
"Can I get the dancers to do .... in .... beats?"

I'll ask you to share your ideas for problems with the rest of the class in five minutes!

Issue pupils with clipboards, 1 cm squared paper, pencils, and rulers. Some pupils have
also found it helpful to use coloured counters when working on Dance Moves.

Pupils explore the microworld and generate problems 10 minutes

Allow pupils 5 minutes to explore what happens as they type numbers into the software.
Go round, encouraging pupils to describe what is happening precisely.

Spirolaterals
So tell me how the computer knows what to draw when you enter those numbers.

Dance Moves
Tell me exactly how the dancers will move if you press diagonal swing?
Can you show me with counters?

Encourage pupils to write down some ideas for problems to explore.

Pupils describe what is happening and suggest problems to explore 15 minutes

Describing what is happening:

Spirolaterals
 If I enter these three numbers (1, 2, 3) what will it draw when I press go?
What is the computer doing with these three numbers?

Dance Moves
If I press "Circle right" what do the dancers do?
What angle do they turn through?
Can you give us a demonstration?

Encourage pupils to describe what is happening as clearly and fully as they can. For
example, they might say:

Spirolaterals
You start by facing to the right.
You move 1 unit forward then turn left 90°
You move 2 units forward then turn left 90°
You move 3 units forward then turn left 90°.
You move 1 unit forward then turn left 90°.
... and so on repeating 1,2,3 until you get back to the start.
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Repeat this process with other numbers until you think pupils know how the program draws
the shapes.

Dance Moves
The dancers each move forward and join hands to form a 'square'.
They then rotate through 270° anticlockwise.
They then step backwards.

Pupils may like to come out to the front and give a demonstration! This isn't as easy as it
sounds for some as the orientation of the moves can confuse them.

Suggesting problems to explore

Now brainstorm possible problems to explore and list some on the board or flipchart. Pupils
might suggest ideas such as the following:

Spirolaterals
• What will happen if we enter a single number and press "Go".

2 numbers? 3 numbers? 4 numbers?
Can we predict the types of shapes we will get?

• What happens when we change the order of the numbers?
So how is (1,2,3) different from (1,3,2)?

• Do the shapes always go back to the start?
When do they? When don't they?
How can we predict this from the numbers?

• When do the shapes have rotational symmetry?
Can we predict this from the numbers?

• When do the shapes have line symmetry?
Can we predict this from the numbers?

• What happens if we enter the same number more than once?
What happens with 3 numbers, like (1,1,2); (3,2,3)?
What about 4 numbers, like (1,3,4,4)...?

Dance Moves
• How can we get the dancers to do a dance and then back to their original

positions?
What different ways are there of doing this?
How many different numbers of beats are needed?

• What other different positions can the dancers end up in?
How can we represent these positions?
How can the dancers reach these different positions?

• Are there impossible configurations?
How can we be sure that they are impossible?

• Can we find a dance that lasts, say, 64 beats so that the dancers end up where
they started?
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Ask pupils to choose a particular problem to work on. Encourage them to be systematic as
they try to answer their problem.

Discuss how they should record their work.

When you think you have some hypotheses or conjectures, I want you to be able to
show me the evidence for this. So as you work, try to keep careful notes of what you
try. You may like to copy some of the diagrams by taking screen shots and pasting
them into a word processor.

Pupils work on the problems 20 minutes

As pupils work on the problem, prompt them to think strategically and analytically:

Can you state your problem to me clearly?
What examples have you tried so far?
What are you keeping fixed? What are you changing?
Can you do this in a systematic way?

What have you found out so far?
Can you see any patterns or relationships here?
Can you explain why your idea seems to work?

How are you keeping a record of your work?
Can you use a helpful notation?
Why do you need to do this?
Can you use the computer to do this?

Pupils report back and share findings 10 minutes

When most pupils have made significant progress with their problem, invite a few pairs to
come to the front and communicate their ideas to the rest of the class. They can show
some patterns on the software itself, projected for others to see. It does not matter if some
have not yet reached any conclusions. They can still share their approaches and ideas.

Let's stop and share some of the different approaches we have used and consider
what you have discovered.

Tell us about:
• the problem you are solving;
• how you have organised your work;
• any conclusions you have reached so far.
• any explanations you have for your answers?

As pupils share their ideas, ask others to contribute suggestions, further examples or
counterexamples and ideas of what to do next.

For homework, pupils could be asked to write an account of their discoveries.
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1 Two microworlds to explore

Spirolaterals

Type some numbers into the Spirolaterals machine.
Press "Go" and watch what happens.

• How do the numbers control what is drawn on the screen?

• List  some questions to explore.
These might start like this:
"How can we make the computer draw ....?"
"What will happen if  we .....?"

Try and answer your own questions!

• Make up some conjectures. These might start like this:
" When you use three numbers then ..."
" When you repeat a number then ..."
" If you change the order of the numbers then ..."

Can you prove your conjectures?
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1 Two microworlds to explore (continued)

Dance Moves

Try clicking the different buttons on the software:

• Describe, as precisely as you can, what each button does.

• Write down some problems that occur to you.
These might start like this:
"How many different ways...?"
"How can I make the dancers move so that...?"
"How many beats would....?"
"Can I get the dancers to do .... in .... beats?"

Now try to solve your own problem.

• Make up some conjectures.
These might start like this:
" You can make the dancers reach every position in ..."
" It is impossible to ..."

Can you prove your conjectures?
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3 A checklist for using ICT

Please don’t be offended if the following advice seems obvious and patronising - we all
suffer from occasional 'common sense failure' when confronted with ICT!

Choose appropriate ICT resources

• How will ICT contribute to the learning?
• Will the ICT be used as a thinking tool, a microworld or as a didactic tool?
• Who will be choosing whether or not to use the ICT?
• Which ICT resources will be available: an interactive whiteboard, data projector,

graphical calculator projected on to a whiteboard, one standalone computer, a suite of
computers, or a class set of graphical calculators?

• What software can I choose from?

Moving the whole class to an ICT lab is disruptive – and inevitably moves the focus of a
lesson away from the maths and towards the hardware. Ideally, pupils should come to see
ICT as part of their everyday mathematical toolkit. This is not easy, given limited resources.

• If you do have computers, graphic calculators or other ICT resources available in the
mathematics classroom, try to ensure that they are available to any pupil (who can
make a reasonable case for their use) when working on unstructured problems. Don’t
just wheel them out for lessons which “need” them – this applies to other, non-ICT
resources as well.

• If pupils have home PCs but are prevented from using them for maths because of the
cost of suitable software (such as spreadsheets or interactive geometry), remember
that there are often good, free alternatives available.

Prepare the room

• How will the ICT be used? Who will operate it?
• How will you arrange the room so that pupils have the space to discuss, and record

their work, and so that you can monitor what they are doing?

Some school computer suites leave little desk space for writing – yet many ICT-based
investigations are almost impossible without paper for notes and rough work. When
recording, especially when using mathematical symbols and diagrams, word processors
are no substitute for clipboards and paper.

Test the ICT resources

• Have you installed and tested the software on pupils' computers – not just your home
machine or one reserved for staff use?

• If your school has a network, have you made sure that your software works when you
are logged in as a pupil?

• What replacement activity will you use if there is, for example, a power cut?

Check the system requirements for your software, and whether anything needs to be
installed before use. Some software requires “installation” to ensure that files are copied
into specific places – you might need IT support to achieve this on a school network or
computers with strict security settings.
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Many  educational  “microworlds” and “applets” – can be run online, or just by opening a
file, but they may also require specific “plug-ins” or “players” such as Flash Player, Adobe
Reader, Java or QuickTime. These are usually free downloads – but will need installing.
Even if you already have them, there may be a newer version available – worth checking if
you are having problems.

Some “interactive” web sites – or other software that runs in a web browser can be blocked
by security settings on your computer. Usually you will be offered an “allow blocked
content” button – or similar.

Plan the types of output required

• How will pupils save their work?
• How will pupils share their work with yourself and others?

Can they project their work so that others may see and discuss it?
Will they be able to use presentation software?

Both you and the pupils will want some record of their work. In some cases, this may just
be written notes, in others a completed document in a word processor or spreadsheet.
Some software might generate custom reports or printouts. Otherwise: Do pupils know how
to capture “screen shots” and paste them into a word processor or presentation program to
record their work? Saving files for later use can be a problem on school computers – find
out from your IT support staff what the rules are at your school and make sure pupils follow
any file naming conventions and save things in the correct place. If pupils are printing out
to a shared printer, remind them ad nauseum to make sure that everything they print
includes their name, and allow sufficient time for this.

Plan the lesson itself=

• How will you group pupils?
• How and when will you work with the whole class?

How and when will you work with small groups/ individuals?
• How will you support/challenge pupils who need extra help/find the work too easy?
• How will you discourage blind trial-and-error approaches?
• How will you enable pupils to present and share their work?

Time in the ICT lab will always be limited – try and make the most of it.

• Avoid taking time on “housekeeping” (collecting/returning homework, announcements)
at the start or end of the lesson – can it wait?

• Try and ensure that the previous lesson is “wrapped up” on time so it doesn’t spill over
into the ICT time.

As soon as pupils get into the ICT room their attention will be drawn to the computers, so it
is not a good environment for conventional teaching.  Some Bowland case studies have
one or more conventional lessons as preparation for an ICT session –  allow plenty of time
for this the first time you try the case study.

For further advice on planning to use ICT, we suggest reading the DCSF publication:
Integrating ICT into mathematics in Key Stage 3: 2003. This is available from:

http://www.standards.dfes.gov.uk/secondary/keystage3/all/respub/ma_integrate_ict
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4 Making and selling a magazine

Some teenagers want to raise money by making and selling a
new magazine.
They conduct a survey to find out how the selling price might
affect the number of people that will buy it.
They ask the following question to 100 people:

This is what they find:

Selling price (£) 0 0.50 1.00 1.50 2.00 2.50
Number of people who would buy
it at this price.

100 82 60 42 18 0

Each magazine costs 10 pence to make.

What should the selling price be in order to make the most money?

Suppose production costs increase... how will this affect your answer?

Using a spreadsheet

Kim has started to solve this problem with a spreadsheet.
See if you can work out what she has done and use the spreadsheet to solve the problem.
(Start by changing Kim's name to your own!)

"How much would you be prepared to pay for
this magazine?"
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5 Spreadsheet Hints

1. Using a formula

For example: Area = Length x Width

A B C D
1
2 Length 6 10 16
3 Width 4 8 9
4 Area =B2*B3

2. Copy a formula across rows…

A B C D
1
2 Length 6 10 16
3 Width 4 8 9

4 Area 20

A B C D
1
2 Length 6 10 16
3 Width 4 8 9
4 Area 20 80 144

See how the formulae change:

A B C D
1
2 Length 6 10 16
3 Width 4 8 9
4 Area 20

Double-click to see
the formula again

This is cell
B2

Multiply the number in
B2 by the number in B3

Drag…

=C2*C3

=D2*D3

Press
Enter

This is cell
B3

 * means multiply
 /  means divide

This is the quickest way!
You can also use Cut & Paste
or the “fill” command…
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3. Advanced: naming cells

You might not have done this in ICT…
Price of carpet = Price per square m   x   Area

A B C D
1 Price per square m (£) 10
2 Length 6 10 16
3 Width 4 8 9
4 Area 20 80 144

5 Price of carpet (£) 200 0 0

4: Teachers: using spreadsheets on a whiteboard

Choose “View -> Zoom” and experiment so that the
spreadsheet is big enough to read easily.

You can also try “View -> Full Screen” to make the most
of the screen.

Ignore the formula bar if it is too small: double-click on
a cell to enter/edit a formula.

(Tools -> Options -> Edit -> Edit directly in cell if it doesn’t
work)

What?!!

=C4 * C1
should be:
=C4 * B1

You type
= B4 * B1

and drag it across…

Beware! Sometimes you want
some bits of the formula to stay
the same when you copy it!

If you want lots of formulae to
refer to the same cell you can
give the cell its own name:

1. Select the “Price” cell

2. Change
this from

B1
To

price

3. Change to    = B4 * price
and drag along…Now if you change the number in

B1 everything will change to
match…
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8 Suggested further reading

A 200 year old problem that can lead pupils to high levels of pupil thinking and activity.
Leadbetter M (2007) ‘More than ladders’ Mathematics Teaching, 207, pp 9-11
http://www.atm.org.uk/mt/archive/mt204files/ATM-MT204-09-11-mo.pdf

An investigation of what teachers see as the issues on teaching mathematics with ICT.
Hennessy, S., Ruthven, K., & Brindley, S. (2005). Teacher perspectives on integrating ICT
into subject teaching: Commitment, constraints, caution and change. Journal of Curriculum
Studies 37 (2) 155-192.
Available online at http://dx.doi.org/10.1080/0022027032000276961

What disaffected pupils can learn with ICT.
Papert, S and Harel I. ‘Situating Constructionism’ in Harel, I. and Papert, S. (1991)
Constructionism, Norwood, NJ: Ablex Publishing Corporation
Available online at http://www.papert.org/articles/SituatingConstructionism.html

Using microworlds in learning mathematics.
Healy’ L. (2008) ‘Charting the microworld territory: the placing of theoretical signposts
Symposium on the Occasion of the 100th Anniversary of ICMI
Available online at http://www.unige.ch/math/EnsMath/Rome2008/WG4/Papers/HEALY.pdf

Coming right up to date with ICT.
Oldknow A (2008) ‘It's 2008 - So what you got to offer, then? - Using ICT to put learners in
touch with mathematics’.
Available online at http://www.mei.org.uk/files/pdf/BectaArticleAOV2.pdf

An overview of 'best practice' with ICT.
Oldknow, A (Ed) (2005) ICT and Mathematics: A Guide to teaching and learning
Mathematics 11-16 using ICT, The Mathematical Association, Leicester
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